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Login to Sabre Red 360

Quick Reference

Log in to Sabre Red 360
After Sabre Red 360 is installed a new red icon appears on your desktop.
Double click this red icon. Sabre Red 360 login window appears.
In Sabre Red 360 login window, input your Sabre Agent ID, Passcode, and
Pseudo City Code (PCC).
Tip: Select Remember Agent ID and PCC to save time the next time you
log in.

Single Sign On
The Single Sign On feature automatically signs you in all work areas upon logging in Sabre Red 360. Therefore, you do
not have to sign in Sabre Red 360 at this time.
However, you will get signed off Sabre Red 360 after a time of inactivity. To sign back in the Sabre Red 360 without
closing the emulator enter the format below:
Sign in to all Sabre Work areas.
Note: To enter a format, type the format in the command line or input row
and then press Enter or click SEND.

SI*(agent ID)
SI*1234

A sign in window displays. Type your Sabre Password and then click Sign
In.
Note: Your own Agent ID and PCC appear automatically in the ID and
PCC/ SUF fields respectively.

Sign Off from Sabre Red 360
To enter a format, type the format in the command line or input row and then press Enter or click SEND.
Sign off from all Sabre Work areas

SO*
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Log Out from Sabre Red
Click the X in the upper right corner or click Exit Sabre Red 360 from the
File menu.
When you exit Sabre Red 360, a warning message requests you to verify
that you want to exit Sabre Red 360. Included is a reminder to finish all of
your PNRs and to sign out of the Sabre system before you close Sabre
Red 360.
This should eliminate error messages the next time you access and log in
to Sabre Red 360, as well as accidentally leaving any unfinished PNRs in
your work areas.

Reset Password
Eight to ten days prior to your password expiring, you will receive a prompt. Follow these steps to reset your password
before the expiration date.
In the manual command line enter SI*(your Sabre agent ID) to display the
Sign in mask.
Select Reset Password.

On the Reset Password mask, enter the current password.
Enter a new password and retype the new password.
Then select Reset.

Your password is now reset.
Select OK.

Sabre Red 360 Graphical Style -Air
Advanced User

Page 4

You can now enter SI*(your Sabre agent ID) and sign in with the new
password.

Additional References
Additional quick references, quick tip videos and interactive tutorials are available on the Web at
http://agencyeservices.sabre.com/ under the Training menu.
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Navigating Sabre Red 360

Quick Reference

Sabre Red 360 in Classic Style
Sabre Red 360 in classic style shows the same text-based output but with drop-down panels, which include more
details, interactive widgets, and next-step action buttons to facilitate the travel booking process.
Three key functions are:
• Using the Command Bar – similar to typing native Sabre formats today, but you no longer type within the screen
below. The Command Bar now supports commands up to 1200 characters long. Click on the pop-out icon to the
right to extend the Command Bar into an easy-to-edit window.

Note: this is by design so that Sabre can now present dynamic rich content right within the workflow
• Using Command History – Allows you to quickly recall previous commands and edit right within the command
bar or re-enter with the click of a button.

• Using Trip Summary – Allows you to easily access Graphical PNR, Add to PNR, and other Command Helper
shortcuts. Also displays PNR progress in a concise view.
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Sabre Red 360 in Graphic Style
Sabre Red 360 in graphic style shows a web-site like design with drop-down panels, which include more details,
interactive widgets, and next-step action buttons to facilitate the travel booking process.
Three key functions are:
• Using the Command Helper Bar – Click Air, Hotel, Car, or PNR to access the graphical options on each module
• Using Command History – Allows you to quickly recall previous commands and edit right within the drop-down
menu or re-enter with the click of a button. You will see an icon showing whether you have e Sabre Red 360 in
graphic style or classic style

• Using Trip Summary – Allows you to easily access Graphical PNR, Add to PNR, and other Command Helper
shortcuts. Also displays PNR progress in a concise view.
Menu Bar
Tool Bar
Command History
Application Launcher Bar

Command Helper bar
Down Arrow

Decision
Support Bar

Widgets
891559

Trip Summary

Panel

Status area
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Menu Bar
The Menu bar contains standard menu categories, such as File, Edit, View, Tools, Window, Help, and Contact Us
Note: Options on the menus may change based on the tasks you are completing
File

The File menu contains options relating to the handling of files, such as Close, Print
Preview, and Print.
The Exit Sabre Red 360 command is located in this menu.

Edit

The Edit menu contains options relating to the handling of information, i.e. Cut, Copy and
Paste along with Selection Commands.

View

The View menu contains options relating to how you view content in Sabre Red 360. It
contains links to Customize your Screen Layout, change from Full to Split screen and
vice versa. You can also see/hide the Memo Area, Reload the screen to start over, Zoom
in/out and go back to Actual Size.
The Customize Screen Layout option provides you the ability to change your default
single screen layout to one of the three predefined multiple screen layouts.
The Connection Details option provides information on your connection to Sabre Red
360 and to Web Services servers.

Tools

The Tools menu contains options relating to the various tools and applications you have
available in Sabre Red 360
Encode/Decode opens the graphical Encode/Decode tool
Quick & PFKeys displays those keys on your screen.
Scribe Scripts provides you a list of the most common Sabre Scripts.
Agency Applications on the Tools menu displays the list of current Agency Applications
along with the Configure Agency Applications option to add links to other applications,
such as MS Word, MS Excel, or MS Outlook, etc. These links then appear on the Tool Bar.
You can customize your Sabre Red 360 experience using the Options window.
• Red Apps Settings allows you to customize settings for each one of the Red Apps
you have downloaded
• Agent Profile allows you to modify the information stored in your Sabre Red profile
• Sabre System allows you to edit settings pertaining to the Sabre connection
options
• Sabre allows you to set up Workflow in Different Areas, change the Input row
position, change the Response styling (Classic or Graphical), and turn Multiple
Responses Display on or off.
 Scribe: Set up Scribe options
 Appearance: Allows you to choose your emulator theme for Classical View for a
selected work area or apply to all Sabre areas
 PFKeys: Allows you to import different PFKey files and set up PF Key position
(top, bottom, or Right-side panel)
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Tools

• General Settings allows you to select your preferred language. Also, you can set up
your Agency Applications, Favorites, and add applications to your Toolbar
• Password Management allows you to establish or modify the Security Questions
and your E-mail Address associated with your password. This area is locked. To
unlock it, click the Lock icon, and provide your Sabre Red 360 login credentials.
Also, it allows you to change your password.
• Sabre Profiles Booking Wizard allows you to enable/disable the capability of
automatically pull form of payment, loyalty, and other information from the profile.
Memo Pad copies your last entry and system response to a memo note for your future
reference.

Window

The Windows menu contains links to all active work areas, Format Finder, and any other
active tab you have opened.

Help

The Help menu allows you to check for Sabre Red 360 software updates, see the History
of updates, run a diagnostic test, check technical information, etc.

Contact Us

The Contact Us menu contains links to:
• Sabre Product Support: Links to the eServices Support page
• Application Vendor Support: Displays a window where you can select the Red App
you need help with and get contact information.

Tool Bar
Favorites

Favorites allow you to customize your favorites by adding up to 15 frequently used
applications to the list of Favorites. You can also see a list of Recent History with the
applications added to the Favorites list. You can remove items at any time as well as
clear the Recent History.

Tools

Tools contains links to the various applications and booking tools for Air, Car and
Ground, Hotels, Tour and Vacation Packages, Cruise, Rail, Customer Management, and
others.
Note: You will only see applications and content that is applicable to your region.

Community

Community contains links to tools such as Agency eServices, iSuggest, Red App Centre,
Sabre Data Suite, Quick News blog, and Quick Look

Admin

Admin contains links to Mobile Sabre Red 360 Device Manager, Sabre Profiles, and Hotel
Program Manager.
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Application Launcher Bar

Application Shortcuts

These are links for Application Shortcuts you selected in the Options menu under
General Settings > Toolbar > Sabre Red 360 Applications. In the example, Sabre Cruises
and Red App Centre.

Agency Application
Shortcuts

These are links for Agency Application Shortcuts you selected in the Options menu under
General Settings > Agency Applications. In the example, Google.

Booking Tools and
Applications

As you access tools and applications under Tools, Community, or Admin you add a tab
for each of those tools or applications. This allows you to easily move among the
various tools and applications you have open. In the example, Agency eServices,
iSuggest, Rail Services, sabre vacations USA, and Agent Connect.
You can rearrange booking tools by dragging the tab into the desired position with your
mouse pointer.

Sabre Work Areas
Work Areas

The new Sabre Red 360 provides a separate tab for each of the Sabre system work areas
– A through F – allowing you to quickly switch from one work area to another. The Single
Sign On feature automatically signs you in all work areas upon logging in the Sabre Red
360 emulator.
Click the desired tab to switch to the work area, or type ¤B, ¤C, ¤D, etc. in the input bar
to switch areas. The current work area is highlighted in green. Work area Labels display
the passenger name (PNR in progress), the record locator plus passenger name (ended
PNR), or the PCC (no PNR active) depending upon what is active in the work area.

Full / Split

You can choose to see your Sabre work area as a single screen or split into two screens.
To change your selection click View on the Menu Bar, and then select Full Screen or Split
Screen.

Classic Style / Graphical
Style

You can choose from two available Response styling.
• Classic Style emulates legacy Sabre Red 360
• Graphical Style provides a graphical interface where you can click and select in a
graphical environment.
To change from one view to the other, click Tools in the Menu Bar, select Options, and
then click Sabre. Select the desired Response Styling.
Note: Both styles allow you to seamlessly change from the Command Helper (graphical
interface) to the Manual Command (native Sabre formats) and back.

Theme

You can choose a color Theme for each different work areas or apply the same to all
work areas. To change your selection, click Tools and then Options; select Sabre and
then Appearance. These settings will follow you on your next sign in.
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Memo Area

Display or hide the Memo area in all work areas. . To change your selection click View
and then Memo Area.

Manual Command/Command Helper Bar
Regardless if you have set up Sabre Red 360 to Classic Style or Graphical Style, you can switch from Command
Helper to Manual Command and vice versa at any moment. For example, you might be shopping for hotels using
graphical buttons in the Command Helper bar, but then need to type a format to assign your printers; you will need to
change to Manual Command so that you can type your format.
Manual Command:

Profile

The Profile button allows you to access Sabre Profiles for searching and copying
customer profiles to your PNR.

Input row and Send

This is the Input field where you must type formats. Then click Send or press Enter.

Command History

Click the Command History icon to display all the formats you have entered during your
active session. Latest formats appear from bottom to top. Click Execute to select and
enter the format. Click Select to send the format to the input row and make changes
before you enter the format.

PF Keys

Click the PF keys icon to access your programmed PF Keys as well as to Create/ Edit PF
Keys.

Command Helper /
Manual Command

Click the Command Helper/Manual Command icon to switch from Command Helper to
Manual Command or vice versa.
Command Helper: When you choose this option the input row hides and the graphical
icons display allowing you to retrieve a profile, reserve air, car, and hotel, or complete a
PNR all in a graphical environment
Manual Command: When you choose this option, the graphical icons hide, and the input
row appears allowing you to type formats.

Air

Click the Air icon to display the graphical interface for Low Fare Shopping, Shop by
Schedule, and Shop by Fare. You must complete the fields requested for the selected
shopping option and continue with the next graphical steps.

Hotel

Click the Hotel icon to display the graphical interface for Hotel Shop. Fill in your search
parameters and continue with the next graphical steps.
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Car

Click the Car icon to display the graphical interface for Car Shop. Fill in your search
parameters and continue with the next graphical steps.

PNR

Click the PNR icon to Search for a specific PNR, Display a PNR, Add data to PNR, and
End/Ignore a PNR.

PF Keys

Click the PFKeys icon to access your programmed PF Keys as well as to Create/ Edit PF
Keys.

Trip Summary
Click the Chevron/Luggage buttons to collapse/expand the Trip
Summary.
Trip Summary allows you to check how far you have got with
your PNR creation:
• PNR: The PNR record locator displays at the top when the
reservation has been previously ended. For those PNRs
that are under creation, a warning triangle indicates that
mandatory PNR fields are still missing. Click the Add to
PNR option to add more PNR fields.
• Travelers: The number of travelers in your itinerary displays
between brackets. Click the arrow to expand/collapse
traveler’s names; you can Edit/Delete traveler names
provided you have not ended the record before.
• Air: The number of air segments in your itinerary displays
between brackets. Click Air to expand/collapse air segment
information. You can also expand and select:
 Price for Advanced Pricing options such as Segment
Selection, Passenger Type, and other Advanced
Qualifiers
 Seats to display the Seat Map and reserve a seat
 Air Extras to display and sell Air Extras
 Add Hotel to start a Hotel search using the Air Segment
information
 Add Car to start a Car search using the Air Segment
information
 Add Surface sector to insert an ARUNK (surface
segment)
 Delete Segment to delete a segment
• Hotel: The number of hotel segments in your itinerary
displays between brackets. Click the arrow to
expand/collapse hotel segment information
• Car: The number of car segments in your itinerary displays
between brackets. Click the arrow to expand/collapse car
segment information
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• Other: The number of other segments in your itinerary
displays between brackets. Click the arrow to
expand/collapse other segment information
• End & Retrieve: This button allows you to E (End)/ER (End
and Retrieve)/I (Ignore)/IR (Ignore and Retrieve)/IC/EC
(Ignore/End transaction and clone) your reservation
• The Add to PNR option allows you to quickly enter PNR
fields that are missing in your reservation. Click the plus (+)
sign and select a PNR field from the list. Click Add to PNR.

Application Side Area
The Application Side area displays all the available Helper Apps
along with the Red Apps you have downloaded; just the same as
your Ipad or phone would do.
When you access a Helper App, it will display in a pop-up
window or in the Assistant Tool Panel.
Quick and PF Keys: Display your programmed PF Keys at the top
of the screen. Quick Keys are not functional yet.
Scribe Scripts: Display a list of available scripts in a pop up
window.
Format Finder: Display Format Finder in a new tab.
Document and Messaging: Send an email to your travelers with
their itinerary, eticket and eInvoice.
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Status Area – Agent Notifications
Informational and operational notification messages appear once you open Sabre Red 360. You will see them in the
lower right corner of the Sabre system work area.
The RSS icon along with the Unread Notification indicator is
located on the status bar.
Click the Unread Notifications indicator to view a list of
unread notifications. Unread message titles appear in bold
text; then click the name of the Notification to open it. If there
are no unread notification messages, the indicator will reflect
0 (zero).

RSS Unread
Notifications indicator

Check for Updates: You might be required to check for
updates when new versions of Sabre Red 360 are available.
Click Help on the right-hand side at the top in you Menu area.
Then select Check for Updates to download any available
updates. You will be requested to close and re-open your
session. Also, you can “Check for Updates History” in the Help
menu.

Status Area – State of Connection Information
Connection details are available for your current session. The Connectivity indicator is located on the status bar.
To check your connection information double click the
Connectivity icon. Details of connection to Sabre web servers
display on the vertical assistant tool panel.

Connectivity icon

Sabre Customer VPN icon

Additional References
Additional quick references, quick tip videos and interactive tutorials are available on the Web at
http://agencyeservices.sabre.com/ under the Training menu. You may also find additional information Format Finder.
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Screen Preferences
The Options Menu

Quick Reference

Example

You can modify some of the Sabre screen features,
colors, and layout by selecting Tools on the Menu bar
at the top and then Options.

From the Options menu, select Sabre.

Input Row Position

Example

Select Top or Bottom to change the Command bar (Manual Command/Command Helper) position.
Top

Bottom
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Response Styling

Example

Select Classic Style to work in classical view style.

Select Graphical Style to work in graphical view style.
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Appearance

Example

Under Options, expand the Sabre menu and then
select Appearance.
Click the arrow to expand the Theme list and choose a
Theme for your emulator in Classical View.
Then select a specific Work area to apply your theme
selection or check mark the Apply to all Sabre areas
option.

PF Keys

Example

Under Options, expand the Sabre menu and then
select PF Keys.
Select Top, Bottom or Right-side panel to change the
PF Key area position.

Then click the PF Keys button and the PF Keys area
will display at the top, bottom, or right-side panel area
according to your selection. Click the PF Keys button
again to hide the PF Keys.
Note: PF keys default to display at the top of the
screen, below the input row.
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Screen Layout

Quick Reference

Customize Screen Layout
You may want to customize the screen layout in a way that you can share Sabre Red 360 with any other application
you frequently use at work.

Select View on the Menu bar at the top.
Then click Customize Screen Layout.
You will be prompted to indicate whether you
want a Single screen, or you want to Divide
Vertically, Divide Horizontally, or Divide in
Quarters. Make your selection.
Open a side application such as Format Finder
or Agency eServices, and drag and drop it to the
side window. It will resize to fit in the side
window whether it’s vertical, horizontal, or
quarter.
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Toolbar and Favorites

Quick Reference

Toolbar
Sabre Red 360 Toolbar allows you to easily access your Agency Applications from the shortcuts you have saved in
your toolbar.

Display/Hide Labels
To display/hide labels for toolbar icons, select
Tools on the Menu bar at the top and then
Options.
Expand the General Settings options and then
click Toolbar. Select or Deselect the Display
labels for toolbar icons option.

Add Applications to your Toolbar
To add a Workspace Application to the Sabre
Red Toolbar:
Select Tools on the Menu bar at the top and
then Options. Expand the General Settings
options and then expand the Toolbar options.
Click Workspace Applications.
From the Workspace Applications list, select the
ones you wish to add to your Sabre Red 360
Toolbar and click OK.
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To add an Agency Application to Sabre Red 360
toolbar:
You must first add the application to the Agency
Applications list.
Select Tools on the Menu bar at the top and
then Options. Expand the General Settings
options and then click Agency Applications.
Click Add. In the pop up screen, provide the
application Name and Path or click Browse to
select the application. At this point you can
mark the Add shortcut to the toolbar option and
this Agency Application will be added to your
toolbar immediately when you click OK.
If you have not added an Agency Application to
the toolbar at the moment you added it to the
list, you can still do it at a later moment.
Select Tools on the Menu bar at the top and
then Options. Expand the General Settings
options and then expand the Toolbar options.
Click External Shortcuts.
From the External Application Shortcuts list,
check mark the ones you wish to add to your
Sabre Red 360 Toolbar and click OK.

Favorites
The Favorites menu allows you to easily access your preferred Workspace Applications from a customizable list.
To access a Workspace Application from your
Favorites list, expand the Favorites menu and
click the desired application.
Note: A Recent History section is maintained for
a period of time allowing you to access a
previously added shortcut. The Clear button
deletes all history.
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Add to Favorites
To add a Workspace Application to your
Favorites menu.
Click the Add button.
From the list of frequently used applications,
mark your favorites.
Notes:
• You can add up to 15 applications to your
Favorites.
• You can also reach this list and add to
Favorites from the Tools option on the
Menu bar by selecting Options, expanding
General Settings and then clicking
Favorites.
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Working with Work Areas

Quick Reference

Switching Work Areas
Sabre Red 360 provides a separate tab for each of the
Sabre system work areas – A through F – allowing you to
quickly switch from one work area to another.
Click the desired tab or type ¤B, ¤C, ¤D, etc. in the
command line to switch work areas.
The current work area tab is highlighted in green to
differentiated from the inactive gray work area tabs.
Work area Labels display the passenger name (PNR in
progress), the record locator plus passenger name
(ended PNR), or the PCC (no PNR active) depending upon
what is active in the work area.

Appearance
Under Options, expand the Sabre menu and then select
Appearance.
Click the arrow to expand the Theme list and choose a
Theme for your emulator in Classical View.
Then select a specific Work area to apply your theme
selection or check mark the Apply to all Sabre areas
option.
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Workflow in Different Areas
You can select from two different workflow options to define how you want to work in different work areas.
Select Tools on the Menu bar at the top and then Options.
From the Options menu, select Sabre and then select one
of the available options under the Workflow in Different
Areas item.
• Streamed Workflow allows you to see all your work
integrated into one single workflow. Regardless of
what area you have typed a format, all formats and
responses will appear in all areas.
 For example, you may have displayed a PNR in A
and then change to B to display a customer
profile. When you move back to A you will be able
to see both the PNR and the customer profile in
an integrated workflow.
• Separate Context Workflow allows you to keep a
separated workflow on each area.
 For example, you may have displayed a PNR in A,
and then change to B to display a customer
profile. When you move back to A you will see the
PNR but will not be able to see the customer
profile as the workflow has been kept separated.
Note: Ctrl+Backspace clears the screen in all work areas
even if you have selected Separate Context Workflow.

Full Screen vs Split Screen
You may want to see each work area separately in full screen, or you may prefer to split the screen and see your work
areas all at once in the same shared screen.
Select View on the Menu bar at the top and then click Split
Screen or Full Screen to change from one option to the
other.
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Full Screen example

Split Screen example
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Booking Air –
Air Shopping

Quick Reference

Air Shopping
In Command Helper mode, click Air to open the Air module. Select Air Shopping.
Use this option to search for flights by both price and schedule-based availability. Air Shopping eliminates guesswork
in locating low-fare options including alternative airlines, times of day, and inventories.

Air Shopping – To Airport

Click the + sign next to the last flight to add multiple
destinations. Click the – sign next to any flight to remove
a destination.
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Click Add Via if you want to request or avoid a specific
connection city/airport. Enter the airport code. The option
defaults to Include. Click Include to change to Exclude.
If you entered more than one connection code, the first
code displays and a + followed by the number of entered
connections appear. Click the number to expand.
Click Remove Via to clear all specified connections, or
click x next to a specific connection you want to remove.
Click Carrier and start typing a carrier code; then select
the carrier you want to include/exclude.
The option defaults to Include. Expand the drop-down
menu to change to Include, Exclude, and Only.

Cabin allows you to specify specific cabin types.
The option defaults to Include and All cabins. Click
Include to change to Only. Click All cabins to select cabin
types.

Click Time to choose a specific Departure or Arrival time
for the flight leg; click the airplane icon to choose
between Departure and Arrival.

Click the Passengers field to add or remove passengers.
Click + or – signs to increase/decrease the number of
passengers.
Passenger Type defaults to ADT (adult). Expand and
select from the available options if you need to change or
add passenger types.
Select Force Passenger Type if you want to price a
specific passenger type regardless of the fare you will get.
Click Advanced Qualifiers if you need to add more
qualifiers to your search. You can also indicate you prefer
Non-Stop flights by selecting Non-stop only.

Sabre Red 360 Graphical Style -Air
Advanced User

Page 27

Corporate ID and Account Codes from all associated
profiles will be copied in the Air Shopping form when you
copy Profile to PNR.
Note: See Sabre Profile panel quick reference to learn how
to copy a profile into a PNR.

Air Shopping –Destination Finder

The “To” field allows you to select from Airports,
Countries, Top Destinations, Regions, or Themes.
Countries, Top Destinations, Regions, and Themes are
part of the Destination Finder feature and because they
involve a different search logic, the fields on the Air
Shopping screen change for these selections.

Select a Date method (length of stay or departure & return
dates). Enter Minimum and Maximum Fare, and
Earlier/Latest Departure. Click Shop Airfare.
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Destination Finder displays pictures for suggested places
along with prices for the indicated dates. Select an option.
You will be taken back to the Air Shopping screen and all
fields will be populated with the respective flight
information.
Note: You may want to check more than one Destination
Theme. If you choose a new destination theme, the old
one and the new one show separately.

To re-display a previous selection, click the Command
History icon and execute the command that runs behind
the application.

Air Shopping – Calendar Search
Use Calendar Search to search for flight options with Flexible Dates or Flexible Weekends.
• The Flexible Dates option
will populate a fare
calendar with flight
options within + or – 3
days of a chosen date.
• The Flexible Weekends
option will show fares
options for all weekends in
chosen month.

Select Flexible Dates and click
Shop Air Fare.
The matrix displays and the
selection defaults to the fare for
the Departure and Return dates
you provided. However, lowest
fares found appear highlighted
in green. You can click and
change the selection to any fare
and dates that are most
convenient for your passenger.
Click Previous or Next to change
to the previous or Next week.
Click Shop to display the flights
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for your selected fare.
Flexible Dates can be also
accessed from the Decision
Support Tab at the top of your
Air Shopping search results.
Select Flexible Weekends. This
option grays out the Date fields
and requires that you select the
traveling Month. Then click
Shop Air Fare.
The matrix displays the first
week of the selected Month and
allows you to change weeks at
the top of the display.
Click the fare that is most
convenient for your customers
after you advised them the
Depart and Return weekend
dates.
Click Shop to display the flights
for your selected fare.
Whether you have selected “To” an airport or have used Destination Finder, or the Flexible Dates/Weekend Calendars,
when you are done you will click Shop Airfare or Shop to start the search. See the progress indicator line on your
screen until the system response displays. Press Esc if you need to abort the request and return to the Shopping
screen

Air Shopping – System Response
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A Header displays at the top of the response indicating:
• City Pair and dates.
Note: Origin and Destination airport codes are clickable allowing you to make changes from the response
screen.
• Filters: The display will show all Carriers and
all number of Stops.
 You can filter the search results by
selecting a specific Carrier, a specific
number of Stops, Connection Type, or Fare
Type.
 You can also switch the bar to define a
Price range, Connection Time, Flight
Duration, Departure Time and Arrival Time.
• Sort by: You can sort by Price, Trip Duration, or Departure Time. Within your selection, you can make a
secondary choice for sorting search results.
A Decision Support tab displays underneath including widgets for Fare Trend, Travel Seasonality, Alternate Dates,
Fare Range, and Alternate Airports. Click any of these widgets to display a pop over with the requested information.
Note: You can expand/collapse the Decision Support tab by clicking the down arrow.

• Fare Trend displays if there is a tendency for
the fare to go up or down compared to past
dates. Click the current date to check for the
lowest fare and the Non-Stop fare amount.
Click any other column to compare with other
past dates. You may want to have a
conversation with your customer to share
insights about the fare tendency and evaluate
any possible date changes.
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• Travel Seasonality allows you to compare the
travel volume (seasonality) along the year.
Each bar represents a week. The week of your
departure flight is highlighted in blue.
When travel dates are flexible, you may want
to have a conversation with your customer
and offer them the chance to travel in a
different week when the travel volume is
lower. You can click a new column, it will turn
blue and then you can click Reshop to shop
for Air on a lower travel volume week.

• Alternate Dates opens the Flexible Dates
calendar which we have explained previously
in the Calendar Search section.

• Fare Range will indicate what others paid for
this route just, so you know there are better
options you can look for.
• Alternate Airports displays airports close to
your requested city along with the respective
fares. You may want to have a conversation
with your customer in regards of flying to an
alternate airport to get a lower fare.
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More insights are provided stating the Cheapest, the Fastest, and the Best fare to help you to make decisions in terms
of what brings more value to your customer. Best represents a combination of cheapest and fastest, designed for
consultants to quickly find results with attributes that matter to travelers.

From the available options, click the flight of your choice. The flight will display first in the availability response and
you will be able to continue with the booking workflow.
Underneath the Decision Support tab, you will see the availability options that Sabre has found for your request.
Each response is structured in the same panel structure. Use the down arrow to expand the panel to find out more
information about the flight.

• Availability line number
• Preference Indicator – Head & Shoulders; indicates traveler preferences or loyalty programs from profile
• Lock flight functionality
• Airlines/Flight numbers along with airline logos – Roll over a flight number to see operating carrier information
• Origin City and Departure Date and Time
• Connection, if applicable - Roll over a Connection Airport Code to display connection time
• Arrival City and Arrival Date and Time
• Equipment information - Roll over equipment information to display aircraft information
• Baggage information – Roll over the baggage indicator to display baggage allowance information. Click the
baggage indicator to be able to select Show free baggage only if you want to see only flights that allow free
baggage.
• Flight time and Booking Class for each segment within the option – Roll over class of service to see Cabin
information
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• Total Fare for all passengers – Roll over the total fare to see a breakdown of base fare and taxes for each
passenger type. Underneath the total fare you will see three Quiet Indicators that can be grayed out when
nothing applies, or colored when some of the following applies:
 Mark Up Indicator – Gear; indicates auto-mark up or ability to manually mark-up or mark-down a fare. A green
indicator means the fare has been marked up automatically, while a blue one indicates a manual mark up.
Click the Mark Up Indicator to manually apply a markup.
 Private Fare Indicator– Circle; indicates private fare. The Private Fare indicator applies to private fares filled
with Corporate ID, Account Code, Private Net fares, Category 35 fares and private fares filled without
Corporate ID or Account Code. A green indicator shows the flight pays commission.
Click the down arrow to expand the information within the Panel:
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Flight information defaults to the first flight in the itinerary which is highlighted in green. Select a different flight to
check other flights’ information.
Below the flights, relevant information regarding exchanges/refunds is summarized for each passenger type. Change
passenger types to check the respective rules. Display complete fare rules by clicking the green pop-out link on the
right. You can click Copy Fare Rules and then paste from your clipboard in a document for future reference.
The panel also shows additional flight information (VA*) for each flight, including meals, reliability, air miles, time
difference, baggage allowance, and more.
More Widgets are available for you to check/sell Branded Fares, Display Seat Maps and make seat reservations, as
well as check Route Happy.
Branded Fares: If Branded Options are available, click the
Branded Fares widget, select a branded fare based on
what it includes, and click Sell & Save Price.

Seat Map: Provided you have moved the customer’s
profile into the PNR, you can make seats reservations
now by clicking the Seat Map widget.
There is a w seat characteristic “Seat with leg room” that
has been added to Graphical Seat Maps.

Click Sell &Save Price.
Note: It is highly recommended that you move the customer profile to the PNR, or at least enter the passenger name,
prior to selling and saving the price.
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Booking Air – Air Availability

Quick Reference

Air Schedules
In the Command Helper mode, click Air to open the Air module. In addition to three shopping options available (Air
Shopping, Air Availability and Fare Quote), you can access flight schedules.
Click Air Schedules and specify city pair, dates and time.
You may include or exclude a carrier from the Air Schedules request or specify direct flights only.
Select Extended Schedules to display timetables for a specified day plus the next 14 days. Extended Air Schedules are
available in both graphical and classic styling.
Click the right arrow to show air schedules for the next day, and the left arrow to display schedules for previous days.

Click Search Schedule
Right-click the Air Schedule display if you would like to print, or copy the displayed results.
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Also, click “More schedules results” to display more options.
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Air Availability
Click Air Availability to request flights for schedule-oriented customers.

Click Add Via if you want to request a specific connection
city/airport. Add the airport code.

If you entered more than one connection code, the first
code displays and a + followed by the number of entered
connections appear. Click the number to expand
Click Remove Via to clear a previously entered
connection.
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Click Carrier and select the carrier you want to
include/exclude.
The option defaults to Include. Expand the drop-down
menu to change to Include, Exclude, and Only.
Click Time to choose a specific Departure or Arrival time
for the flight leg; click the airplane icon to choose between
Departure and Arrival.

You can also:
• Indicate you Prefer Non-Stop flights
• Look at Direct Access availability
• Add preferred booking classes
Click Advanced Qualifiers if you need to add more
qualifiers to your search.
Additional search parameters include:
• Cabin
• Alliance
When you are done, click Search Availability to start the search. See the progress indicator line on your screen until
the system response displays. Press Esc if you need to abort the request and return to the Shopping screen

Air Availability – System Response

A Header displays at the top of the response indicating:
• City Pair – Click Origin/Destination city codes to request a different city pair.
• Date - Click the Back/Next arrows to display availability for Previous/Next day
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Underneath the Header you will see the availability options that Sabre has found for your request.
Each option is contained in a Panel you can expand by clicking the respective down arrow. Each Panel includes:

• Availability line number
• Airlines/Flight numbers along with airline logos – Roll over a flight number to see operating carrier information
• Origin City and Departure Date and Time
• Connection, if applicable - Roll over a Connection Airport Code to display connection time
• Arrival City and Arrival Date and Time
• Equipment information - Roll over equipment information to display aircraft information
• Booking Classes for each segment within the option
• Additional information related to Traffic Restriction, Subject to Government approval, and EU banned airlines
both in classic and graphical styling

Click the down arrow to expand the information within the Panel:

Flight information defaults to the first flight in the itinerary which is highlighted in green. Select a different flight to
check other flights’ information.
The panel also shows additional flight information (VA*) for each flight, including meals, reliability, air miles, time
difference, and more.
Select number of Passengers and Class of service for each segment on your itinerary, and then select an action:
• Click Sell to sell from the availability display.
• Click Scan availability to check all schedule flights regardless of availability.
• Click Waitlist segment to waitlist a class that is not available.
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Booking Air – Fare Quote

Quick Reference

Fare Quote
In the Command Helper mode, click Air to open the Air module. Select one of the three shopping options available:
Fare Quote: This option is for fare-oriented customers. It displays a fare quote (FQ).

Fare Quote
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Click the + sign on the right of the Date field to add a
return flight if needed.
The reversed city pair will display in the From/To fields;
you are not allowed to edit return city codes. Click the –
sign to remove the return flight.
Optional, request specific Carrier and/or add a Global
Indicator

.
It is possible to search for Government fares only. The fare request uses fare inclusion code GOV, and the fare display
includes fares only for this specific category.
Click Advanced Qualifiers if you need to add more
qualifiers to your search.
Additional search parameters include:
•

Passengers

•

Cabin

•

Journey Type

•

Fare Type

•

Exclude Restrictions – Advance Purchase

•

Exclude Restrictions – Min/Max Stay

•

Exclude Restrictions – Penalties

•

Exclude Restrictions - All

When you are done, click Get Fare Quote to start the search. See the progress indicator line on your screen until the
system response displays. Press Esc if you need to abort the request and return to the Shopping screen.
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Fare Quote System Response

A Header displays at the top of the response indicating:
•

City Pair – Click Origin/Destination city codes to modify the search parameters.

•

Date

•

Currency

•

Filters. You can filter the results by carrier, booking class, global indicator, trip type or price.
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Underneath the Header you will see the fare options that Sabre has found for your request.
Each option is contained in a Panel, which you can expand by clicking the respective down arrow. Each Panel
includes:

•

Line number

•

Airline logo

•

Fare Basis code

•

Operating carrier information

•

Booking Class

•

Fare Type (One Way/Round Trip)

•

Minimum/Maximum Stay

•

Advance Purchase information

•

Seasonality

•

Routing indicator

•

Fare amount and currency type

•

Underneath the Fare amount there are three Silent Indicators that can be grayed out (when no conditions apply),
or colored when one or more of the following applies:
 Mark Up Indicator – Gear; indicates auto-mark up or ability to manually mark-up or mark-down a fare. A green
indicator means the fare has been marked up automatically, while a blue one indicates a manual mark up.
 Preference Indicator – circle; a green indicator means the traveler has preferences or loyalty programs
associated with that carrier, from their Profile.
 Private Fare Indicator – Green flag; indicates private fare, net fare/override, or commission.
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Click the down arrow to expand the information within the Panel:

If available, quick rules for each passenger type will display. Toggle between the different passenger types (if
applicable) to check the respective data. Display complete fare rules by clicking the green pop-out link on the right.

The panel also shows Base Fare amount, Cabin code, Fare Type, Fare Vendor, Passenger Type, Seasonality, Total
taxes, Routing, and more.
Now you can shop the fare from the class of service and sell. There are two possible ways to shop from the fare:
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Click Search Availability to display the
Air Availability screen. It will be filled in
with your itinerary selection plus the
Booking Class that will price with the
quote you selected.
Then click Search Availability to proceed
with your flight selection and complete
your booking.

1

The Air Availability screen displays
allowing you to select the flight.
• Click the down arrow to expand the
information within the Panel.

2

• Your complete itinerary displays.
Click Sell to sell from the availability
display.
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Booking Air –Pricing

Quick Reference

Overview
Regardless of what option you have used, Air Availability, or Fare Quote, all segments are added to the PNR upon
Selling and you are now ready to price the itinerary and store the fare. Make sure you have entered passenger names
or move the customer profile to the PNR before storing a Price Quote Record (PQ). Note: Air Shopping does not
require a pricing entry since you already booked and stored the best flight at the best fare.
Click the down arrow to expand the panel.

Pricing Options
Click Re-Pricing Options to execute
one of the available Pricing
options:
• WPNCB: Rebook to lowest
available
• WP: Price current itinerary
• WPNC: View lowest available
• WPNCS: View lowest
available regardless of
availability
• WPA: Alternative Pricing
• WPAS: Alternative Pricing
regardless of availability
• WPNI: Compare Low Fare
Options
In this example, we have rebooked to the lowest class available with WPNCB. Click Re-Pricing Options if you want to
price differently. Click Modify if you want to manually (WC) re-book a different class of service.
If you need to do name selection or segment selection, add a passenger type or any additional qualifiers, click:
• Advanced Pricing Options:
 Select a Pricing Option
 Select Air Segments
 Select Passenger Name
 Select Passenger Type
 Add Advanced Qualifiers such as: Account Codes, Currency Code, exclude restrictions, Governing Carrier, Max
Penalty, Round the World/Circle Trip, Price by Cabin, and more
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Click Price.

The Pricing panel shows the fare breakdown per passenger type along with the total amount due. Last day to
purchase also displays at the top.

Quick rules for each passenger type display if available. Change passenger types to check the respective data. Display
complete fare rules by clicking the green pop-out link on the right.
The Pricing panel also shows Exchange/Refund information as well as validating carrier and baggage allowance.
Click any of the available widgets for a complete tax breakdown, baggage information, display seat map, offer Air
Extras, or search for Branded Fares.
Note: You need to enter passenger names before you making seat reservations.
Click Save Price. The fare is saved and the Price Quote (PQ) displays. Click Display PNR to continue with your
reservation workflow.
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Air Extras
You can view, price and sell Air Extras from Pricing panel and from the Ticketing tab of the Graphical PNR. Select the
Air extras widget from the expanded panel of the ticket to access Air Extras.

A breadcrumb of the PNR creation
shows at the top, indicating
missing or completed field
indicators.
Home displays by default. Click
Itinerary, Price Quotes, Traveler
Information, Remarks, Ticketing or
History to display specific PNR
fields.
Traveler Information fields display
to the left-hand side allowing you to
quickly Add additional fields.
The Trip Summary wraps up PNR
information on the right column. It
can be viewed at any time.

Sabre Red 360 Graphical Style -Air
Advanced User

Page 49

PNR Module

Quick Reference

Display an Under-Construction PNR
You can display your PNR at any time by typing *A in the command bar, or graphically by clicking PNR in the
Command Helper mode or the Trip Summary.
Upon booking itinerary segments, a breadcrumb of the PNR creation shows at the top, indicating your progress status
along with the missing or completed field indicators. You can look at it at any time, by clicking PNR in the Command
Helper mode.

Home displays a Summary of your reservation.
To display specific PNR fields click: Itinerary, Price Quotes, Traveler Information, Remarks, Ticketing or History to
display specific PNR fields.
A Header on the top displays your progress towards PNR creation, along with missing mandatory PNR fields, which
you can quickly add by clicking the respective field.
Traveler Information displays on the left hand side allowing you to Add additional fields such as Form of Payment,
email, SSRs, and many more.
The Trip Summary wraps up PNR information on the right column. Click Add to PNR to complete missing fields in
your PNR.
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Trip Summary

Quick Reference

Trip Summary
The Trip Summary allows you to:
• Click the arrow on the Trip Summary to expand/collapse the information
• An ended PNR shows a record locator. A warning triangle displays
whenever there are missing mandatory elements to the PNR
• Click Add to PNR to add additional PNR fields
• Click Travelers to display PNR name filed. You can Add or Delete names
from the name field display. In the Trip Summary, the number of
travelers displays between brackets. Click the arrow to expand/collapse
the Travelers names. Edit, Add, and Delete buttons are also available
from here.
• Click Air to display PNR Air Itinerary only. In the Trip Summary, the
number of air segments display between brackets. Click the arrow to
expand/collapse the Air field. You can perform additional actions from
here:
 Click “See all Air” or “Less” indicators to see or hide segments when
your itinerary includes more than three air segments.
 Click the three vertical dots next to each air segments as a shortcut
to Price, book Seats, Sell Air Extras, Add Hotel, Add Car, or Delete
Segment
• Click Hotel to display PNR Hotel Itinerary only. In the Trip Summary, the
number of hotel segments display between brackets. Click the arrow to
expand/collapse Hotel segments and take additional actions.
• Click Car to display PNR Car Itinerary only. In the Trip Summary, the
number of car segments display between brackets. Click the arrow to
expand/collapse Car segments and take additional actions.
• Click “Other” to display PNR “Other” segments only.
• Expand the End & Retrieve button for more options: E – ER – I – IR – IC
- EC. Click to execute.
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Add to PNR
To display a list of all fields you can graphically add to
your PNR, click Add to PNR in Trip Summary.
Select a filed.

The selected field will display on the Add to PNR screen.
You can complete it now or you can expand the list again
and select more fields to add.
Note: +/- signs next to a PNR field allow you to add or
delete data
When complete, click Add to PNR

End PNR
• Expand the End & Retrieve button for more options:
E/ET – ER – I – IR – IC/EC. Click to execute.

Display a Previously Ended PNR
Click PNR in the Command Helper mode.
Search Types defaults to Traveler Name but you can select
Record Locator from the available options. Enter the
information accordingly and click Search PNR.
Note: If you enter Last Name only, the response will
include all PNRs for that last name or similar.
Other options are available from here, such as Display an
active PNR, Add fields to an active PNR, End a transaction.
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If there is more than one PNR matching the traveler’s name, a list of PNRs display allowing you to see passenger
name, record locator, contact information, and a Display button. Click Display to retrieve the desired PNR.

You can also search for travelers with similar names by selecting: Exact mode, Similar mode and Start mode.
• The Exact mode searches for exact spelling.
• The Similar mode compares words that are spelled differently alike in English.
• The Start mode searches based on what the word “starts with”.
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Sabre Profiles Panel

Quick Reference

Access Sabre Profiles
• Click the Profile Icon to open Profiles and the Search Panel
or
• Click Sabre Profiles from the Helper Apps side bar.
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Search Profiles
• Search in:
 Current PCC: This option searches within the PCC you are signed selecting it from the list. All Branch PCCs
appears at the bottom of the list.
• Profile Type:
 You can search by a specific profile type by selecting it from the list or keep the default of Any. Available
Profile Types are:
 Any, Traveler, Agency, Family Group, Group Other, Corporate and Operational.
• Profile Name – enter the full or partial profile name
• Email Address – (Optional)
• Phone number – (Optional)

Click Advanced to add additional search qualifiers
Once you have entered the search criteria, click Search Profiles.
The Search results appear on the screen. If there is more than one profile that matches the search criteria, a list is
displayed.
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You can see the Traveler’s name, the PCC where the profile is stored, the phone number and email address if they are
populated in the profile, as well as the associated profile name.
To expand the panels to see more details, click the
on the right-hand side of the screen. You will be able to see the
unique Profile ID, the descripton of the profile, an address, and traveler’s date of birth.

Copy to PNR
Click Copy to PNR if you want to use this profile for the booking.
Click View to see the full profile, or Edit to open the administration panel and make changes to this profile.
Note: You can still use the Command Line to use Sabre commands to search for profiles such as N*PROFILE NAME or
N*CORPORATE PROFILE-TRAVELER PROFILE or NLIST/S, etc. Please, see the Quick Reference Guide, Using Sabre
System Commands for more information.
Corporate IDs and Account Codes from all associated profiles will be prepopulated in the Air Shopping form when
copied over.
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Copy to PNR from a List

Move one profile from a list to the PNR

NM(profile line number)
NM2

Navigating the Full Profile View
To view full profile view, click Expand/Collapse All
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Pin the
Profile
indicator

Return to the
Search screen
smith
Profile history
Travelers
PNR
Search for
Edit the
Profile

Editable
profile
sections

information

Copy Profile to
PNR

within the Profile

Inline Editing
You can now quickly and easily change something in the profile without leaving the agent panel. Simply click on the
pencil icon next to the field you’d like to change.
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You will be able to add or edit the information in a box.
Click Save.

Note: If you need to add a new field or delete a field, you need to do it in the administration panel.

Associated Profiles
You can view an Associated Profile, for example a corporation or another traveler which is associtated to the profile
you are searching from, and copy it to the PNR
In this example, a Corporate Profile is displayed that has 5 Traveler profiles associated from it.
Click the Associated Profile to display it.
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Click Copy to PNR, and then click the < icon to return to the Corporate Profile that was initially displayed.
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Pinned Profiles
You might need to have the profile data visible while you are shopping and booking. You can now pin a profile to the
side so you can refer to the information as necessary.
Click on the pin icon to pin a profile.

When you pin a profile, the icon becomes highlighted in green.
The pin icon on the right side of the screen will have a
small green dot next to it when profiles are pinned.
Just click the pin icon to open the pinned profile,

Additional References
Additional quick references and interactive tutorials are available on the Web at http://agencyeservices.sabre.com/
under the Training menu. You may also find additional information in Format Finder.
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